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Welcome
From an original development in 1988, Virtual TimeClock has grown up into a
general purpose replacement for mechanical time clocks and hand written employee
time cards. Virtual TimeClock is a continuing work in progress. It's future is in
large part determined by your support and feedback.

Features
Virtual TimeClock uses the internal clock on your Macintosh to record your employ-
ees arrivals and departures in much the same way as a mechanical time clock and
time card. Virtual TimeClock can be started and quit as needed on an employee's
computer. Alternatively, it can run continuously in the background of a departmen-
tal Macintosh computer. Many businesses are running Virtual TimeClock as a
dedicated program on older, otherwise unused Macintosh in a centrally located time
clock area.

Virtual TimeClock provides the following benefits to your business:

Convenience

* Freedom from the cost and maintenance of a mechanical time clock.

* Saves historical time card data on an electronic time card
 (No more time cards to buy!)

* At a glance knowledge of who is clocked in and out.

* Convenient backup of electronic time card data.

* Easy to file standard size paper reports and time card histories.

* ‘Try before you buy' fully functional shareware version.

Confidence

* Accurate information on employee arrival and departures.

* Optional administrative password protection for all administrative features.

* Optional password protected employee clocking in and out.

* Optional password protected time card access.

* Automatic tracking of all manually performed modifications or additions.
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Flexibility

* User selectable weekly, biweekly, twice monthly or monthly payroll periods.

* Allows user selectable overtime calculations on a daily or weekly basis.

* Print one time card, all time cards, a summary, or export to your accounting
or payroll program.

* Activate and deactivate employees and their time cards 'on the fly'.

* Calculate time in hours and minutes or portions of hours.

Time Saving Reports

* Automatic and accurate totals per period, per employee.

* Optional calculated overtime for on a daily and/or weekly basis.

* Convenient time card summary reports.

* Export totals for emailing, archival or importing into payroll programs.

System & Memory Requirements
Hardware Requirements

Virtual TimeClock 2 requires a color Macintosh with a 68020 processor or better.
Faster is always better! Virtual TimeClock will run native on newer Power
Macintosh computers while still running just fine on older 68K Macintosh
computers.

System Requirements

Virtual TimeClock  requires System 7.1 or newer. Version 2 has been extensively
tested with Apple OS 8.6 and equipment from a relatively ancient Macintosh IIci to
a new B&W G3 400.

Memory Requirements

Virtual TimeClock requires 3 MB of free memory.

Virtual TimeClock Classic

The Classic edition of Virtual TimeClock is a black & white program which runs on
System 6.07 or higher with 1200K of RAM available.
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The Classic version of Virtual TimeClock will run on a Macintosh Plus/Classic and
reasonably get the job done. It is anything but a speed demon when performing
report calculations (ka-chunk, ka-chunk, ka-chunk).

Contact Information
Keith DeLong, the author of Virtual TimeClock, can be reached via email at:
keith@redcort.com

The latest Virtual TimeClock news and information is available on the Internet at
the following address:   http:www.redcort.com

The Internet, evolutionary as it is, may not know about the above Internet address
by the time you read this. If the address above is no longer valid, you will continue
to be able to find Virtual TimeClock's latest home and version by doing a search for
Virtual TimeClock at your favorite on-line archives or search engine.
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Shareware Information
This software is distributed fully functional as ‘Try Before You Buy’ shareware. You
may use this software for a period of 30 days to evaluate its usefulness to your
business. A reminder of the software's unregistered status will appear at launch
after about a weeks use. A shareware reminder of the program’s unregistered status
will be displayed on the time clock window and on all of your reports.

License Fees
Single Computer License

If you continue using this software beyond your 30 day evaluation, you are required
to purchase a software license. Each license is for a single Virtual TimeClock pro-
gram running one computer at one business site. In the spirit of shareware, the
license fee follows a simple sliding scale as follows:

$29.95 for a single employee business
59.95 for businesses with up to 10 employees
99.95 for businesses with over 10 employees (unlimited use)

This sliding scale allows affordable license fees appropriate to the size of your com-
pany and the proportional benefits you receive in using Virtual TimeClock. A
registration acknowledgment and serial number will be to you within 48 hours of
processing your registration.

Site Licenses

Site Licenses allow you to license and run Virtual TimeClock on multiple computers
within your business. Site licenses allow an unlimited number of employees on each
registered computer. Site licenses can be used at multiple store/business locations
as long as all sites are operating using the same company name.

   Total Computers Site License Fee
         2          $149.
         3 199.
   up to 5 299.
   up to 7 399.
   up to 10 499.
   Unlimited (1 company) 999.

Complete registration information and pricing can be found on the registration form
on page 14.
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Registering
Payment Method

Payment can be made via Check, Credit Card, or a purchase order from an Aca-
demic Institution. (For POs, the Tax ID number is 566-45-6795).

Depending on the selected form of payment, registrations can be processed on-line
or via postal mail, email, or even fax.

How to Register

There are many ways to obtain a registration form for Virtual TimeClock:

1.  Print the registration form on page 14 of this manual.

2.  Print the text file ‘Registration Form’ in the  Virtual  TimeClock folder.

3.  Select REGISTER/UPGRADE BY MAIL/FAX from the Contact menu within

Virtual TimeClock. This will present you with a dialog to complete and print for
mailing or faxing.  A reproduction of this same form is available for printing from
this manual on page 14.
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‘4.  Select REGISTER/UPGRADE ON-LINE from the Contact menu within Virtual
TimeClock.

5.  If you do not have an Internet connection for the computer running Virtual
TimeClock, you will find the Virtual TimeClock on-line registration page by
typing the following into any web browser with Internet access:

http://www.redcort.com/register

Entering Your Serial Number
Once you have received your serial number, your copy of Virtual TimeClock can be
registered by entering the serial number into your program.
To register your copy of Virtual TimeClock 2:
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1.  Double-click the Virtual TimeClock Icon.                        

 Virtual TimeClock

 2.  Select SERIAL NUMBER from the Contact menu.

 

3.  Enter your company name and serial number as shown on your registration.

4.  Select the radio button corresponding to your user license.

5.  Select the REGISTER button.



Registration Form

Virtual TimeClock Software Registration
© Copyright 1996-99 by Keith C. DeLong Redcort Software

Purchase a Software License      License Upgrade
(For use on one computer)       (Upgrade version and/or # of employees)

o  ‘1 Employee’ $29.95 o   Version 1 to 2 Upgrade $19.

o  ‘Up to 10 Employee’ 59.95 o  ‘1 Employee’ to ‘10 Employee ’ 49.

o  ‘Unlimited Employee’ 99.95 o  ‘1 Employee’ to ‘Unlimited’ 79.

o  ‘10 Employee’ to ‘Unlimited’  49.

Purchase a Site License (Unlimited employees, multiple computers and/or business locations)

o   2 Computers $149. o  Up to 7 Computers $ 399.

o   3 Computers 199. o  Up to 10 Computers 499.

o   Up to 5 Computers 299. o  Unlimited Computers 999.

Company

Contact

E-Mail

Address

City     State  Zip

Country     Telephone

Payment

o Check

o Credit Card    (circle one)  VISA        MasterCard          Discover           American Express

                                         EuroCard     Diner’s Club      Carte Blanche       Optima       JCB

Card Number   Expires

Name on Card

Signature

Mail, Fax, or Email this form with a check or valid credit card information

Payable to:   Redcort Software Fax:         (559) 435-7412
1156 E. Quincy Avenue, Suite 100 Email:      register@redcort.com
Fresno, California  93720  USA On-Line:  www.redcort.com/register

Serial number follow-up

A serial number with registration instructions will be emailed to you (or mailed by request),
licensing your installed copy of Virtual TimeClock. Registration serial numbers are normally
prepared and emailed within 48 hours of receipt of your registration information.
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This chapter covers two very different kinds of upgrades for Virtual TimeClock -
Program upgrades and License Upgrades.  License and program upgrades can be
done at the same time or separately.

Specific upgrade information for your particular program or license will always be
included with the actual upgrade files and/or license numbers. The sections below
describe the overall reasons of upgrading and the process to initiate and perform an
upgrade.

Program Upgrades - Getting a Better Program
Upgrading your program is done when you want to begin using a later release
version of Virtual TimeClock. A new program release occurs when new features are
added and/or bugs are removed from the Virtual TimeClock program.

Minor upgrade releases typically occur every three to four months. Minor upgrades
are released as features are perfected and bugs are fixed. These bugs are often only
discovered when Virtual TimeClock is deployed in a variety of ways on many thou-
sand different hardware/software configurations. Minor program upgrades are
always free to registered users of Virtual TimeClock.

Major program releases add significant new functionality and program features.
These types of upgrade releases occur about every twelve to eighteen months. Regis-
tered users can benefit from the new functionality of a major new release by paying
a discounted upgrade license fee.

When you register virtual TimeClock, you are automatically put on an emailing list
that keeps you notified of new features and fixes as they occur in each  new release
of Virtual TimeClock. The latest release version of  Virtual TimeClock is always
available on the Internet at the Web Site location listed on the title page of this
manual.

Performing a Program Upgrade
Most often, an upgrade to Virtual TimeClock consists of three basic steps:
1. Move the newly downloaded version (the entire the Virtual TimeClock folder) to
the computer in which you want to upgrade Virtual TimeClock.

2. Drag your time card file from the old Virtual TimeClock folder to the upgraded
version of the Virtual TimeClock folder. Omit this step if you store your time card
file in a separate location from the program (i.e. on a network).
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It is a real good idea to give your time card file a unique name to help you recognize
which time card file holds your company’s time card data. Using your company
name (i.e. ABC Company Time Cards) is pretty clearly your company’s time card file
and not a blank time card file that was included with the program or upgrade.

3. The final step links the upgraded Virtual TimeClock program with your existing
time card file. Open the new version of Virtual TimeClock and select CHANGE
TIMECARD FILE from the File menu.



Upgrading
Chapter 3

Virtual TimeClock ©1996-1999 Keith DeLong   18

To complete the link, locate and open your company’s time card file for use with the
new version of Virtual TimeClock.

The resulting dialog box will display a list of usable time card files within in the
Virtual TimeClock folder. If your timecard file is stored in another folder, you will
need to navigate to the timer containing your existing time card file.

As long as your old time card file is recognized by the new version of Virtual Time-
Clock, the new release of the program is able to use your existing time card file. If
your time card file is not recognizable to the new version of Virtual TimeClock, you
will need to import your time card information into a new 2.2 time card file. See the
next section which details the import process.

Upgrading Time Card Files
Occasionally, a new release of Virtual TimeClock makes changes to the time card
file format. This creates a need to move the time card data from your previous
version of Virtual TimeClock into the latest version.

Fortunately, moving your employee time card information to an upgraded release is
easy with the import provision included beginning in version 2.2 of Virtual Time-
Clock.



Upgrading
Chapter 3

Virtual TimeClock ©1996-1999 Keith DeLong   19

The import action merges all time card information from an original time card file
to a version 2.2 time card file. Time cards can be imported from any version of Vir-
tual TimeClock into a 2.2 file.

To begin a time card file import, select IMPORT  from the file menu:
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From the resulting dialog box, you can press either of the buttons labeled ‘Select...’
to open the time card files you wish to import from and/or export to.

Notice that the complete path to the import and export files is displayed. This is to
help prevent any confusion as to which exact file is being exported and imported.

A file path is simply a list of the names of the folder(s) the file is stored in all the
way from the hard disk level down to the file name itself. In the Macintosh environ-
ment, each folder level is separated by a colon (:). In the example below, the import
file is named ‘Time Card File’. It can be found on the hard disk named “Macintosh
HD” within a folder named ‘Virtual TimeClock 2.2’.

Though not required, it is recommended to move your export time card file into your
new Virtual TimeClock 2.2 folder before doing an import. This will simplify the
process and help ensure you locate, selecting and import the desired time card files.
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When you have successfully selected the time card files you want to get data from
and copy it into, select the button labelled ‘Import’. All employee time card data is
copied from the ‘Get time card data from’ file into the ‘Import time card data into’
time card file.

User Preferences & Program Upgrades
Your current payroll period, administrative password, and all other user defined
preferences are always preserved when upgrading Virtual TimeClock to a new
version.

A logical default preference value is assigned to any new features that may be
added in the new release. See the chapter  entitled ‘User Preferences’ (later in this
manual) for further information on setting user preferences.
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License Upgrades - Adding More Time Cards
Virtual TimeClock, like nearly all computer software, is licensed. Your purchase is
for a license to use the program in your business, not a purchase to the rights of the
program or it’s source code. Each license is purchased for a single Virtual TimeClock
program running one computer at your business site. Additional licenses must be
purchased for each copy of Virtual TimeClock running within your business organi-
zation. See the final chapter ‘Software License’ for a more complete explanation of
your rights and limitations in purchasing a software license for Virtual TimeClock.

License Types
Virtual TimeClock is licensed on a sliding fee scale according to the number of
employees you have using Virtual TimeClock. This allows affordable license fees
appropriate to the size of your company and the proportional benefits you receive in
using the program.  Currently there are 3 categories of licenses:

Single Employee License Used for personal or single employee time tracking.

Under 10 Employee License  Allows up to 10 active employee time cards.

Over 10 Employee License Allows an unlimited number of active time cards.

Available License Upgrades
Virtual TimeClock license upgrades enable you increase your number of active
employee time cards. A ‘Single Employee’ license can be upgraded to an ‘Up to 10
Employee’ or an ‘Over 10 Employee’ license. An ‘Up to 10 Employee’ license can be
upgraded to an ‘Over 10 Employee’ license.

Performing a License Upgrade
Upgrading your Virtual TimeClock license is the same process as obtaining your
original license. A Registration/upgrade form is completed and mailed, emailed, or
faxed with the appropriate license fee. License upgrades can be processed on-line at:

http://www.redcort.com/register

After processing your payment and upgrade request, a new program serial number
is created and returned to you for entry into your Virtual TimeClock program.  Your
new license is immediately recognized by Virtual TimeClock once the new serial
number is entered into the program.

See Chapter 2 (Registration) for detailed instructions for processing registrations
and entering your serial numbers into Virtual TimeClock.
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Installing Virtual TimeClock
On-line Version

The Virtual TimeClock file available on the Internet is distributed compressed and
encoded. It can be easily decoded and unstuffed using the freeware program StuffIt
Expander®  (http://www.aladdinsys.com/expander/expander1.html) or the commer-
cial equivalent program StuffIt Deluxe® (http://www.aladdinsys.com/deluxe)
Both are by Aladdin Systems, Inc. (http://www.aladdinsys.com, (408) 761-6200).

Once unstuffed, the Virtual TimeClock folder contains all the Virtual TimeClock
files. The first time Virtual Time Clock is started, it creates a preference file in the
Preferences folder within the System folder.

Virtual TimeClock's 'all in one folder' design allows you to help me by putting Vir-
tual TimeClock on a disk and giving it to your business friends for their evaluation.
While you are encouraged to share the program with others, please don't distribute
your Virtual TimeClock registration number! Your support of Shareware keeps
Macintosh software affordable for the entire business community.

Diskette Version

By request, Virtual TimeClock is available on diskette. The Diskette version is
compressed in a self extracting format that doesn’t require any additional software.

1.  Insert the Virtual TimeClock diskette in your Macintosh and wait a moment for
      it to be mounted on your desktop.

2.  Double click on the diskette to open it.

3.  Double Click on the Virtual TimeClock Icon.                        

          Virtual TimeClock 22.sea

4.  Select a destination folder. Virtual TimeClock is unstuffed and copied to your
local hard drive.

Moving Between Computers
The Virtual TimeClock folder can be moved to another computer without losing its
functionality. In order to move the program on a floppy disk, the Virtual TimeClock
folder will need to be compressed, stuffed or otherwise zipped.
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In order to maintain your user preferences on the new computer, make sure you
also copy the "Timeclock2 Prefs" file found in the Preferences folder within the
System folder.

Preferences are stored within the program in the black & white 'Classic' version of
Virtual TimeClock.

Program Components
As originally distributed, Virtual TimeClock includes at least the following files:

The Virtual TimeClock Program

Virtual TimeClock

The data file where all time card information is stored

   TimeCard File

The folder containing program documentation.

Documentation Folder

Program Updates & Replacements
The most current versions of the Virtual TimeClock program, the time card file and
user documentation can be easily located and downloaded from Internet at the web
site address provided on the front title page of this manual.

See chapter 2 of this manual (Upgrading) for complete program upgrade informa-
tion and instructions.
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Program Overview
Virtual TimeClock 2 consists of two main components, a time clock window and an
employee time card file.

The time clock window consists of two lists designated 'Employees Out' and 'Em-
ployees In'. The employees in and out lists are built and maintained using the data
stored in the employee time card file.

The employee time card file is a small data file that consists of an electronic time
card for each employee. All of your employee time card information is stored in the
time card file.

Launching Virtual TimeClock

Virtual TimeClock

When you double-click the Virtual TimeClock program icon for the first time, a
number of things occur. Several of the start up actions may require input from you,
the user:

A preferences file is created for you that will store all of your user settings. If you
have version 1 of Virtual TimeClock on your computer, it will recognize this and ask
you if you want to copy your user preferences from version 1.

Virtual TimeClock looks for a time card file. If it cannot find one, it asks you to
locate your time card file. Although it can be stored anywhere, by default the time
card file is found within the Time Card Folder that is within the Virtual TimeClock
folder. If a time card file is not properly located, Virtual TimeClock is forced to quit.

Lastly, the main time clock window opens. This window informs you of the current
date and time along the top of the window. It also gives you two lists of your active
employees those employees who are 'clocked in' and those who are 'clocked out.'

Clocking In and Out
When you first use Virtual TimeClock, the time card file is set up with one employee
with the name of 'Employee (Click Me)'. The reason for this unusual name will
become clear as the functionality of the time clock is understood.
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‘Employee (Click Me)', as an active employee, is displayed in the time clock window
list 'Employees Out'.

To move (or 'Clock') an employee 'In' or 'Out', perform one of the following:

1.  Click on an employee name, then select the top button (between the In & Out
lists). The top button will be appropriately entitled ‘Clock In’ or ‘Clock Out’ depend-
ing on which list the selected employee resides in (In or Out).

2.  Double click on an employee name in the time clock window.

Either operation causes (1) the selected employee's time card to be time stamped as
'In' or 'Out' and (2) the employee name to be moved to the opposite list in the time
clock window  (from  ‘Out' to 'In' and vise versa).
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Try this exercise:

(1) Click on 'Employee (Click Me)'  in the ‘Employees Out’ list. You’ll notice the top
button between the time clock fields becomes active with a name of  ‘Clock In >>’.

(2)  Select the button ‘Clock In >>’. The employee is clocked in.

(3) Click on 'Employee (Click Me)' now in the ‘Employees In’ list. You’ll notice the
buttons becomes active.

(4)  Select the ‘Time Card’ button (second button from the bottom). This action opens
the time card for the employees selected.

You will notice that ' 'Employee (Click Me)' has a time card. In fact it is the only
time card since the time card reads '1 of 1’ at the bottom.

10/15/1999      7:58 AM
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You will also see today's date displayed with a 'Clock In' time shown under the first
'In' column. Since many companies have their employees clock in and out at lunch,
there are two 'In' and two 'Out' columns for each date. In practical use, your busi-
ness may have only one in and out per day or your employees may clock in and out
several times using more than one line. Virtual TimeClock manages all these sce-
narios providing a sophisticated yet simple time clock program!

(5)  To return to the time clock window, select OPEN TIMECLOCK from the File
menu, or press command-T, or select the ‘TimeClock’ button at the bottom of the
actual time card.

Changing the ‘Employees In/Out’ Time Clock Labels
Since it’s inception, many new types of businesses, schools and even businesses in
other countries have begun using Virtual TimeClock. Version 2.2 adds a feature to
accommodate those who would like to change Virtual TmeClock’s default ‘Employ-
ees In’ and ‘Employees Out’ list headings.

(1)  Select IN/OUT LABELS from the Edit menu.

(2)  Enter the new label headings in the resulting dialog box and select ‘Save’. The
Time Clock window will be automatically updated with the new  list headings.
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The Time Card File
All employee time card information is stored in a time card file. Virtual TimeClock
is packaged with an empty file called, appropriately enough,  “Time Card File”.

It is highly recommended that you do the following before use the time card file:

1.  Create your company’s time card file using a copy of the original time card file.
The blank original time card file can be safely stored as a backup (with the Virtual
TimeClock program) on a floppy or other removable disk.

2.  Rename your time card file to easily identify that it has your company’s time
card information in it (i.e. ABC Company TimeCards). The name of your time card
file will be displayed on the header of the time card window when it is open. Addi-
tionally, by naming your time card file and assigning a unique name to each backup
you create (i.e. "June 1999 Time Cards"), you will always have a convenient way to
know that Virtual TimeClock is connected to and using to the desired time card file.

Linking to a Time Card File
Virtual TimeClock is always linked to a particular Time Card File. The particular
linked time card file can be changed at any time by choosing SELECT TIME CARD
FILE form the File menu.
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A dialog box appears asking you to open the time card file that you want to link to
Virtual TimeClock.

After selecting a time card file and pushing the ‘Open’ button, Virtual TimeClock
builds a list of employees in and out (according to the newly linked time card file)
and displays the lists in the time clock window.

Virtual TimeClock remembers the Time Card link as long as the files are not moved
or folders renamed. If Virtual TimeClock loses its link to your time card file, it
prompts you at start-up to locate your time card file.

Navigating Time Cards
After launching Virtual TimeClock (double-clicking on the ‘Virtual TimeClock’ icon),
the time card file can be opened and viewed in three different ways:

(1)   Click on an employee name and then select the ‘Time Card’ button in the time
clock window,

(2)   Option-click on an employee name in the time clock window, or

(3)  Select OPEN TIMECARDS from the File menu. This method simply opens the
time card file to the first time card in the file.
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Once you are in the time card file, you can navigate between time cards in five
different ways:

(1)   Use the ‘Next’ and ‘Prev’ buttons on the face of a time card,

(2)   Use the arrow keys on your keyboard,

(3)   Select the FIRST, PREV, NEXT, and END commands from the TimeCard menu,

(4)  Use the command key equivalents to the navigational menus: Command-1,
       Command-2, Command-3, Command-4,

(5)   Select the FIND command in the Edit menu and enter the employee name you
        wish to find.
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Creating New Time Cards
To create a new employee time card:

Select OPEN TIMECARDS from the File menu (or press command-T).

You will notice the TimeCard menu becomes enabled once you are in the time card
file. Select NEW CARD from the TimeCard menu (or press command-N).
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When you create your first employee time card, Virtual TimeClock gives you the
option to modify the time card with the name “Employee (Click Me)” or leave it and
create a new time card.

Once you have modified the “Employee (Click Me)” time card, Virtual TimeClock
moves directly to the new employee time card dialog.

Enter the employee's name (First Last, i.e. John Doe) and optionally, their Social
Security Number.  Press 'Create'.

At the next dialog, you can enter an employee password (optional). Employee pass-
words are used if you set the User Preferences (Edit menu) to require a password to
clock in and out and/or to view employee time cards.
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A common password used for employees is their birth date. They will usually not
forget it while it is unlikely to be immediately known or easily remembered by other
employees.

If you enter a password for the employee, you will be prompted to confirm the pass-
word by reentering it.  Additional employee time cards can be created by repeating
the above steps.

As long as your number of active employee time cards is less than your licensed
number of employees, new employee time cards are automatically made 'Active' (as
shown by the check box selected in the lower right corner of the time card).
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Active Verses Inactive Employees
When the “Active Employee” check box is selected, the employee is declared “active”
by Virtual TimeClock. When the check box is unselected, the employee is declared
inactive by the program.

Being an 'Active Employee' has two consequences:

(1)   The employee's name is shown on the Time Clock list as in or out. Inactive
        employees cannot be seen in or use the time clock.

(2)   Active employee’s are included in time card reports. Inactive employees are
        excluded from all time card payroll reports.

If you have seasonal workers, employees on vacation, or an employee out for an
extended period of time, you may want to make the employee ‘Inactive’ to remove
them from the time clock lists and time card reports.

Modifying Employee Information
Clicking directly on an employee name or Social Security number on a time card
brings up a modification dialog allowing changes to be made and saved.

The TimeCard menu also provides menu commands for modifying the employee
name, social security number (SSN) as well as an additional command to modify or
create a password for the employee.
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Modifying Time Card Data
The time card is stamped by Virtual TimeClock with a date and time every time
they clock in and out. If an employee forgets to clock in or out, a manager (someone
with the administrative password) is able to make manual adjustments to the em-
ployee time card.

In order to protect the integrity of your time cards, every manual time card modifi-
cation is flagged as a line modified (MOD) or a line manually added (ADD) on your
time card reports.

Missed Clock Ins

An employee who forgets to clock should be instructed to clock in as soon as they
remember and then request a manual adjustment to their time card. This can be
done by management at a convenient time.

Missed Clock Outs

The employee who finds they forgot to clock out will be prompted by Virtual Time-
Clock when they next attempt to clock in.  The program posts a placeholder Clock
out for the previous day that is the same as the employee’s clock in.
For example, if an employee clocks in at 8:05 AM on 7/1/99 and forgets to clock out
at the end of the shift. He then arrives for work on 7/2/99 and attempts to clock in.
Virtual TimeClock automatically does the following:

(1)  The employee is notified of the missed clock out on 7/1 and instructs them to
        inform management of the need for a manual adjustment.

(2)  The employee is clocked out on 7/1 at 8:05 AM  (netting out to zero hours until
       an agreed upon clock out can be determined and added by management.)

(3) The employee is then clocked in for their 7/2 shift.

The time clock administrator can, at a convenient time, easily go back and modify
the employee's time card to reflect the actual clock out time for 7/1.

Date & Time Modifications

The administrative password (if active)  is required for all manual time card modifi-
cations. You can either double-click on a time card entry you wish to modify or select
a card modification command from the TimeCard menu.
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Double-clicking on a time card line presents the time card modification dialog:

.

Changing any of the recorded times and pushing the ‘Save’ button  records the
changes and marks the line on the time card as manually modified (MOD).

Pushing the ‘Delete’ button removes the entire line from the time card.

The following modification commands are available on the TimeCard menu:

ADD A DATE ...
This command allows you to manually insert a new time clock line (with manually
entered times) into a time card.
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DELETE DATES...
This command deletes a range of consecutive dates from a time card or all time
cards. It’s primary use is to remove older historical time card data. The user is
prompted to backup the time card file before deleting any range of times data.

MODIFY DATE...
Modify date simply prompts you to double-click on the line you which to modify. It is
included for completeness and to aid those new to using Virtual TimeClock.

ERASE TIMECARD
 This command erases all time card information from either the current or every
employee time card.

Viewing Time Card Totals
Selecting PRINT PREVIEW from the File menu (while in the time card file) selects,
totals, and displays the employee’s time card for the current payroll period.

Selecting PRINT TIMECARD from the File menu (while in the time card file) se-
lects, totals, and prints the employee’s time card for the current payroll period.

See chapter 7 (Reports) for instructions on the setting of your current payroll start-
ing date and frequency as well as other time card reporting capabilities.

Deleting Time Cards
Selecting DELETE CARD in the TimeCard menu deletes the current time card. At
least one time card is necessary to remain in the timecard file as a place holder for
the TimeCard data structure.
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Payroll Period Settings
Every time card report is based upon a certain payroll period. Without a pay fre-
quency and payroll period starting date, meaningful reports cannot be generated.

Setting the Payroll Period

Select CURRENT PAYROLL PERIOD from the Edit menu.

A dialog displays the current payroll period stating date, the next period’s starting
date and the frequency in which your company pays your employees - either weekly,
biweekly, twice monthly, or monthly.

The following page explains the purpose and use of the ‘Starting Date’ and the
‘Frequency Settings’ buttons.
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Starting Date
Clicking the button 'Starting Date’ button displays a calendar. Double-click on the
correct payroll starting date or select the date and close the calendar window.

Frequency Settings
Selecting the ‘Frequency Settings’ button (or selecting PAYROLL FREQUENCY
from the Edit menu) brings up a dialog with a  drop down list to select weekly,
biweekly, twice monthly, or monthly payroll frequencies.

If Twice Monthly or Monthly payroll frequency is selected and saved, an additional
dialog is presented to enter each period’s starting day.  After entering the starting
day(s), Virtual TimeClock returns you to the Current Payroll Period Settings Dialog
to confirm your starting date, frequency, and period starting day selections.

Any inconsistencies within your payroll period settings must be reconciled before
Virtual TimeClock will save and dismiss the current Payroll Period Settings Dialog.
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Reporting Preferences
Selecting 'Preferences' from the Edit menu displays the User Preferences dialog.
You will notice that the preferences dialog allows you to customize how Virtual
TimeClock functions according to your business needs and preferences. See the
expanded preferences information in chapter 9 to learn more about your user
preference options.

Time Card Reports
Virtual TimeClock provides four different employee time card reports. Each report
confirms the current payroll period and pay frequency setting before printing.

After printing a time card report, Virtual TimeClock gives the user the option to
update the current payroll period reports.
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Unregistered versions of Virtual TimeClock print a shareware reminder on each
time card report. The registered version of the program prints your company name
on the top of each report page.

Reports from the Time Clock Window
From the time clock window, the File menu presents the following report options:

PRINT SUMMARY
Selecting ‘Print Summary’  creates a report that presents totals for each employee’s
regular, overtime, and total hours for the current payroll period.

PRINT REPORT
Selecting ‘Print Report’  creates a report that presents  each employee’s daily
regular, overtime, and total hours as well as totals for the current payroll period.

EXPORT
Export creates a comma separated text file (CSV) of a time card summary or report
for the current payroll period. The exported file can be used to import data into
most popular payroll programs.

Alternately, an exported report can be securely sent as an email attachment to a
remote payroll department that doesn’t use Virtual TimeClock.
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The USER PREFERENCES command (Edit menu) provides report exporting
options for including file headers, employees with no hours for the period, and mak-
ing exported reports read-only so they cannot be easily edited.

Reports from the Time Card File
In addition to a Summary, Report and Export described above,  there are two
additional report menu items available when you have the time card file open.

PRINT THIS CARD
This command causes Virtual TimeClock to calculate and print the regular, over-
time, and total hours for the current payroll period.

PRINT PREVIEW
This command causes Virtual TimeClock to calculate and display on screen the
regular, overtime, and total hours for the current payroll period.

These two menu selections allow you to either preview or print a single time card.
Neither of these commands are protected by the administrative password, allowing
employees to easily view or print their current period time card at any time.
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Date & Time Control
Virtual TimeClock uses the standard Macintosh system time. The 'Date & Time'
control panel can be deleted from your Control Panels folder (found in the System
folder), preventing unauthorized manipulation of the Macintosh system clock.

Several solutions exist for businesses desiring to restrict employee access to the
system date and time while preserving the ability to periodically reset the
Macintosh  system date/time.

If your Macintosh has a floppy disk drive,  a floppy can be prepared containing the
Date & Time Control Panel application. Simply insert the floppy and double-click on
the Date & Time Control Panel to alter or correct the system time.

The Date & Time Control Panel can be moved to a separate utilities folder. The
control panel can still be launched from within this utilities folder without being
obviously available to your Virtual Timeclock users.

If honesty is a major issue in your business environment, initiate a clear 'immediate
termination' policy for altering the system clock or clocking other employees in or
out.  This type of policy is widely used in businesses using mechanical time clocks
and serves an effective way to remove any temptation to disturb the accuracy of
your Virtual Timeclock. It is always wise to consult your attorney for proper word-
ing before publishing or promoting new employee policies.

Compacting Files
Virtual TimeClock automatically reads and writes relatively small amounts of
information to a singular file over and over during extended periods of time. Data
files of this kind tend to become less efficiently arranged and stored over time.

Upon quitting Virtual TimeClock, the program automatically checks the data file
and periodically compacts and writes a fresh copy of your data files to the hard disk.

Since many businesses leave Virtual TimeClock running continuously, a manual
method to compact and rewrite your data files is useful.

Selecting COMPACT FILES from the File menu manually initiates this same
process of compacting and writing a fresh copy of your data files to the hard disk in
order to preserve optimum performance of the program and data files.
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Backing Up
Given the importance of your time card information, it is very important to
develop a regular habit of backing up your time card data files. A large time card file
with over 20 employees and a year’s worth of time card data will still back up in a
few moments onto a standard floppy disk.

The BACKUP TIMECARDS... command under the File menu allows convenient
backup of your time card data file.  Selecting this command opens a standard file
dialog for saving a copy of your current data file.

You can easily create periodic historical backups for archival purposes and/or prior
to deleting older time card information from your time cards.  A naming scheme
with dates for each backup - i.e. “1/1 - 6/30 1999 TimeCards” - allows immediate
recognition of the contents of this time card file.

For detailed instructions on viewing archives or restoring from a back up of your
time card file, see the section in chapter 6 (Time Cards) regarding Linking time card
files.
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The Administrative Password
The administrative password limits access to maintenance, time card modification,
preference and reporting features of Virtual TimeClock by requiring the entry of the
administrative password before carrying out any of these activities.

Since the purpose of the administrative password is to restrict access, it is helpful to
avoid creating or using an administrative password as you are learning or setting
up Virtual TimeClock. Not using an administrative password prevents being regu-
larly requested to enter the administrative password as you explore the program's
features and access it’s administrative functions.

Creating an Administrative Password
The administrative  password can be created and activated at any time by selecting
ADMIN PASSWORD from the Edit menu.

The administrative password dialog box displays your password characters with
bullets (•) rather than the actual letters and numbers. This prevent unintended
disclosure of the password to others who may be watching your computer screen.
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After initially entering your administrative password, you will be asked to confirm
your password by retyping it a second time. This ensures that what is thought to be
typed is consistent with the password that is saved.

Modifying the Administrative Password
Once an administrative  password exists, it can be can modified at any time by
again selecting ADMIN PASSWORD from the Edit menu.

When there is an existing administrative password active,  the Admin Password
menu itself is actually administratively protected. That is, you are prompted to
enter your current password before being allowed access to the menu’s function.
This protection prevents unauthorized change or disablement of the administrative
password.
Once you have given your current password, you are prompted to enter a new pass-
word and then confirm  the new password before saving the new password.

Deactivating the Administrative Password
To either temporarily or permanently disable the administrative password, select
ADMIN PASSWORD from the Edit menu. After entering your current password,
enter no characters at all for a new password and then select 'OK'.

When Virtual TimeClock encounters an empty password string, it displays a prompt
asking if you want to stop using an administrative password.

••••••••••
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Selecting the ‘Yes’ button deactivates all administrative password protection.

Forgotten Administrative Password
For security reasons, there is no easy way to bypass the administrative password. If
you forget or lose your administrative password, contact us at Redcort Software
immediately via email or fax using the address /fax information located on the front
title page of this manual.

Employee Passwords
Each employee with a time card can be optionally assigned an employee level pass-
word. Employee passwords are activated for two different functions within Virtual
TimeClock:

1.  Employees can be prompted to enter their password in order to clock in and out,

2.  Time cards can be protected, requiring an employee password for viewing.

To ensure administrative flexibility,  Virtual TimeClock will accept the administra-
tive password in place of any request for an employee password.

Activating Employee Passwords
Selecting PREFERENCES from the edit menu opens the User Preferences dialog
that allows for the activation of either or both of these employee level password
protections.
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CLOCKING IN & OUT
Selecting this check box creates the requirement for an employee password (or the
administrative password) in order to use the time clock (clocking in and out).
Unselecting this option allows clocking of an employee in or out simply by clicking
on the employee name.

VIEWING TIME CARDS
Selecting this check box creates the requirement for an employee password in order
to use the time clock or open the time card file.

When this option is enabled, time card access is limited to an employee’s own time
card without allowing access to other time cards. The keyboard arrow keys and
navigational menus in the TimeCard menu are disabled. Unselecting this option
allows anyone access and view any employee time card.
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Creating Employee Passwords
Employee passwords are prompted for and optionally entered when a time card is
initially created (see chapter 6, entitled ‘Time Cards’ for more information on creat-
ing employee time cards).

Modifying Employee Passwords
Employee passwords can be created or modified at any time for employees who
already have time cards created in Virtual TimeClock. To create and/or modify an
employee password, first you must access the employee’s time card. From the Time
Clock window:

(1) Option-click on an employee name, or

(2) Select OPEN TIMECARDS from the File menu and use the arrow keys to
      move to the desired time card.

Select MODIFY PASSWORD from the TimeCard menu.

The employee password dialog box displays your password characters with bullets
(•) rather than the actual letters and numbers. This prevent unintended disclosure
of the password to others who may be watching the computer screen.
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After entering your employee password, you will be prompted to confirm your pass-
word by retyping it a second time. This ensures that what is thought to be typed is
consistent with the employee password that is saved.

Forgotten Employee Passwords
Follow the proceeding instructions above for modifying an employee password.
When prompted to enter the original employee password, enter your administrative
password in its place.

To ensure administrative flexibility,  Virtual TimeClock will accept the
administrative password in place of any request for an employee password.
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Opening User Preferences
User Preferences are accessed by selecting PREFERENCES from the Edit menu.

The User Preferences dialog allows customized control of Virtual TimeClock.

The following description details the role of each of these preference settings.

Calculating Time Worked
ROUND TO QUARTER HOURS
Selecting this check box causes Virtual TimeClock to round and calculate employee
hours worked into quarter hour segments. Deselecting this option causes all hours
to be calculated to the minute. The time is calculated according to "the seven
minute rule".
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The ‘Seven Minute Rule’ for rounding is probably best demonstrated by an example:

Actual Time              Calculated Time           Latest arrival
7:53 - 8:07 AM                 8:00 AM  up to 7 minutes past the hour
8:08 - 8:22 AM                 8:15 AM  up to 7 minutes past 8:15
8:23 - 8:37 AM                 8:30 AM  up to 7 minutes past 8:30
8:38 - 8:52 AM                 8:45 AM  up to 7 minutes past 8:45
8:53 - 9:07 AM                 9:00 AM  up to 7 minutes past 9:00

Since the same rules apply for clocking in and out, the credits and costs related to
this rounding process tend to even themselves out, creating a payroll and time
schema that credits hours worked in neat 1/4 hour increments.

TOTALS IN MINUTES
Selecting this check box causes Virtual TimeClock to calculate totals in hours and
minutes (3:15 = 3 hours and 15 minutes). Unselecting this check box causes Virtual
TimeClock to calculate in hours and portions of an hour (3.25 = 3 1/4 hours).

Calculating Overtime
CALCULATE DAILY AFTER...
Selecting this check box causes Virtual TimeClock to calculate overtime hours ac-
cording to the threshold number of daily hours entered. Unselecting this option
prevents Virtual TimeClock from any calculation of daily overtime.

CALCULATE WEEKLY AFTER...
Selecting this check box causes Virtual TimeClock to calculate overtime hours ac-
cording to the threshold number of weekly hours entered. Unselecting this option
prevents Virtual TimeClock from any calculation of weekly overtime. Weekly over-
time is ignored when using twice monthly or monthly payroll periods.

Exporting Time Cards
INCLUDE HEADERS (FIELD NAMES)
Selecting this check box causes Virtual TimeClock to export field headers along the
top row of the exported file. The export field header is "Name, SSN, Starting Date,
Ending Date, Regular Hours, Overtime Hours, Total Hours".

INCLUDE TOTAL IF 0 HOURS WORKED
Selecting this check box causes Virtual TimeClock to include all time cards with 0
hours worked in the export period. Unselecting this option causes employees with
zero hours to be excluded in the exported file.
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EXPORT FILES AS 'READ-ONLY'
Selecting this check box causes Virtual TimeClock to save the file in the Simple Text
'read-only' file format. This is useful when there is a desire to have control over the
integrity of the exported file (e.g. when the exporting is done by the employee
remotely and emailed or sent to payroll for processing).

See Chapter 7 (Reports) for complete instructions on exporting time card reports.

Report Defaults
1 TIME CARD PER PAGE
Selecting this check box causes Virtual TimeClock to print one time card per page
on a time card report. Unselecting this option causes Virtual TimeClock to print
time cards in a continuous format.

PRINT A SUMMARY
Selecting this check box causes Virtual TimeClock to print a time card summary
report automatically when you print a time card report. Unselecting this option
causes Virtual TimeClock to not automatically print a summary with your time card
reports.

Password Protection
CLOCKING IN & OUT
Selecting this check box creates the requirement for an employee password (or the
administrative password) in order to use the time clock (clocking in and out).
Unselecting this option allows clocking of an employee in or out simply by clicking
on the employee name.

VIEWING TIME CARDS
Selecting this check box creates the requirement for an employee password in order
to use the time clock or open the time card file.

When this option is enabled, time card access is limited to an employee’s own time
card without allowing access to other time cards. The keyboard arrow keys and
navigational menus in the TimeCard menu are disabled. Unselecting this option
allows anyone access and view any employee time card.
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Miscellaneous
CLOCK IN/OUT SOUND
The ‘Clock In/Out Sound’ is turned on by default. This check box allows users the
option of an audible chime that sounds with each employee clock in and out.

INVISIBLE TIME CARDS
Selecting this check box causes Virtual TimeClock to make the active time card
invisible from the desktop. Invisible files are unseen by normal users opening up
folders from the Macintosh desktop. Making the file with the employee time card
information invisible helps prevent it from being accidentally  (and even deliber-
ately) dragged to the trash or otherwise deleted.

This feature is not highly secure in that a number of programs can ‘see’ and easily
display hidden Macintosh desktop files. This feature will prevent casual accidental
(and deliberate) deletions of employee time card files.
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Distribution
Virtual TimeClock (the Software) is a copyrighted work. Virtual TimeClock is not in
the public domain. It is freely distributed as shareware. As shareware, you are
encouraged to give an unlicensed copy of this software to another individual or
business if you include this document and all other related materials that came
with this software package. The software may not be sold, incorporated into other
products, or in any way commercially sold or marketed without the prior written
consent of the author.

License
No license exists during the evaluation period of the software. Unregistered Soft-
ware is not warranted and is distributed 'as-is' for the purpose of evaluating the
usefulness of the software for a 30 day period.

Once the software is properly registered, the software remains is the property of
Keith C. DeLong (dba Redcort Software), or his licensers and is protected by copy-
right law. While Keith DeLong continues to own the software, you will have certain
rights to use the software after your registration and acceptance of this license.
Except as may be modified by a license addendum which accompanies this license,
your rights and obligations as a registered used of this software are as follows.

What You Can Do

Use one copy of the Software on a single computer;
(1)   Make one copy of the software for archival purposes or copy the software onto
the hard disk of your computer and retain the original for archival purposes;

(2)  Use the software on a network, provided that you have a licensed copy of the
software for each computer that can access the software over that network;

(3)  After written notice to Redcort Software, transfer the software on a permanent
basis to another person or entity, provided that you retain no copies of the software
and the transferee agrees to the terms of this agreement.

What You Cannot Do

(1)  Copy or in any way modify the documentation which accompanies the software;

(2)  Sublicense, rent or lease any portion of the software;

(3)  Reverse engineer, decompile, disassemble, modify, translate, make any attempt
to discover the source code of the software, or create derivative works from the
software; or
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(4)  Use the serial number provided with this license or any previous serial number
used to upgrade this license, on more than one copy of the software.

Limited Warranty
Your sole remedy in the event of loss resulting from the use of the software will be
that Redcort Software will, at their option, refund the money you paid for the soft-
ware. Keith DeLong and Redcort Software do not warrant that the software will
meet your requirements or that operation of the software will be uninterrupted or
that the software will be error-free.

The above warranty is exclusive and in lieu of all other warranties, whether express
or implied, including the implied warranties of merchantability, fitness for a par-
ticular purpose and non infringement. This warranty gives you specific legal rights.
You may have other rights, which vary from state to state.

Disclaimer
REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF
ITS ESSENTIAL PURPOSE, IN NO EVENT WILL KEITH DELONG BE LIABLE
TO YOU FOR ANY SPECIAL, CONSEQUENTIAL, INDIRECT OR SIMILAR DAM-
AGES, INCLUDING ANY LOST PROFITS OR LOST DATA ARISING OUT OF
THE USE OR INABILITY TO USE THE SOFTWARE EVEN IF KEITH DELONG
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME
STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY
FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITA-
TION OR EXCLUSION MAY NOT APPLY TO YOU. IN NO CASE SHALL KEITH
DELONG or REDCORT SOFTWARE’S LIABILITY EXCEED THE PURCHASE
PRICE FOR THE SOFTWARE.
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